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Preface

This documentation provides information on Natural Single Point of Development (SPoD).

What's New? Describes the new features, enhancements and corrections that apply
to this release of SPoD.

Introducing Natural Single Point of What is SPoD? Products belonging to the SPoD architecture.
Development Advantages and benefits.

SPoD Administration Policies and Provides information which is required to be able to administer a
Procedures Natural development environment that is based on the SPoD concept.

First Steps with Natural Studio This tutorial provides an introduction to Natural Studio which is part
of the SPoD concept. It is intended for developers who are not yet
familiar with the Windows version of Natural.

When using Natural for Windows (Natural Studio) as the development client, see Prerequisites for
Natural Single Point of Development at
http://documentation.softwareag.com/natural/spod_prereq/prereq.htm (Empower login required)
for detailed information on the supported products.

When using NaturalONE as the development client, see your Natural ONE documentation for
detailed information on the supported products.

Vii


http://documentation.softwareag.com/natural/spod_prereq/prereq.htm
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What's New?

This chapter describes the new features, enhancements and corrections that apply to this release
of Natural Single Point of Development (SPoD).

Debug Attach Support

Natural Development Server supports the debug attach mechanism of NaturalONE. It is thus
possible to debug Natural programs on a Natural RPC server that are called by a Natural RPC
client program running on the Natural server. For more information on the debug attach mechan-
ism, see the NaturalONE documentation.

| Note: The current version of Natural Development Server for OpenVMS does not support

the debug attach mechanism.

Documentation

NaturalONE also makes use of Natural's Single Point of Development concept. For information
on the differences between NaturalONE and Natural Studio, see Natural SPoD Architecture.

This SPoD documentation continues to focus on how to perform remote development with Natural
Studio. It only contains documentation for the plug-ins that can be used with Natural Studio. For
detailed information on NaturalONE and the optional components which can be used with Nat-
uralONE, see the NaturalONE documentation which is available separately.

| Note: Due to last-minute documentation updates, it may be possible that the documentation

that you can download with the Software AG Installer or that the online help that you can
invoke directly from the product does not yet contain the latest information. The most up-
to-date documentation can always be found on the Software AG documentation website
at http://documentation.softwareag.com/ (Empower login required).

4 Natural Single Point of Development
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II Introducing Natural Single Point of Development

This part covers the following topics:

What is Natural Single Point of Development?
Remote Development Interface

SPoD Application Concept in Natural Studio
Natural SPoD Architecture

Natural SPoD Frequently Asked Questions
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What is Natural Single Point of Development?

Introduction

If you have been developing applications using Natural in a non-graphical environment, you have
undoubtedly become familiar with Natural's wide range of capabilities and most likely also with
some of its inconveniences and shortcomings. You have probably quite often wished for a more
advanced user interface for “your Natural”. With Natural Single Point of Development, your wish
has indeed become reality.

Simply speaking, one might say that Natural Single Point of Development is an integrated devel-
opment environment (IDE) for Natural application development for different platforms.

Actually, the Natural Single Point of Development concept covers more than a simple IDE in that
it combines the advantages of two disparate worlds:

" the strengths of the character-based Natural products and
" the ease of use provided with Natural ONE and Natural for Windows.

Natural Single Point of Development is more than wishful thinking - it is indeed one Natural IDE
for all.

The Idea Behind SPoD

Natural's Single Point of Development approach is Software AG's response to the increasing demand
for a state-of-the-art development workstation for building, testing and maintaining all Natural
applications throughout their lifecycle and across all supported platforms.

The standard SPoD architecture comprises the following products:

® NaturalONE
NaturalONE is a development client that is based on Eclipse and which can be used in Windows
and Linux environments.

* Natural for Windows
Natural for Windows is a development client that is based on Software AG technology and
which can be used in a Windows environment. Natural for Windows includes Natural Studio,
which is the actual interface where software engineers design applications.

* Natural Development Server
Natural Development Server (NDV) resides on each Natural installation in the target environ-
ment, enabling it for remote development. It is available for mainframes (z/OS, z/VSE,
BS2000/0OSD), UNIX, Linux, OpenVMS and Windows. The development server maintains a
development server file (FDIC) for loading information and application definitions.

8 Natural Single Point of Development



What is Natural Single Point of Development?

® Natural for the target platform
Natural at the target platform plus Natural Development Server make up the Natural develop-
ment server environment.

Optionally:

® Natural Security
Natural Security can be used for both the development client and the development server, if
you wish to secure the local environment or the target environment.

Additional development products and tools can be integrated to make up a full-flanged Natural
development environment for increased developer productivity. For example:

" Predict
Predict is an active data dictionary system which is used to describe information processing
systems. It also provides functions to use this information when designing, implementing, using
and maintaining the system.

You can use the optional Predict component of Natural ONE to document Natural sources in
Predict via NaturalONE, manipulate and retrieve data stored by Predict on the server, and
manage external objects (generation and administration). See the NaturalONE documentation
for further information.

If you are working with Natural Studio, you can use the following plug-ins: Natural X-Ref
Evaluation plug-in, Object Description plug-in, Schema Generation plug-in.

* CentraSite
You can use the optional Lifecycle Manager component of NaturalONE to deploy Natural ap-
plications (or specific versions of Natural applications) to different environments and to keep
track of the installed applications in each environment. The Lifecycle Manager is based on
CentraSite and uses Natural projects. See the NaturalONE documentation for further information.

® Predict Application Control (PAC)
PAC is a flexible tool for controlling Natural and foreign applications throughout the software
lifecycle and for ensuring the integrity of applications in the production environment. PAC fa-
cilitates and controls the movement of applications through the lifecycle. When an application
is implemented into production, it is protected and audited by Predict Application Audit (PAA).
If you are working with Natural Studio, you can use the Object Versioning plug-in.

® Natural Construct
Natural Construct is a powerful, easy-to-use, model-based application generator that helps you
create and implement high-quality, robust Natural applications.

You can use the optional component Natural Construct component of NaturalONE to reuse
your existing Natural Construct models in NaturalONE, and to create new Natural Construct
models or code frames. See the Natural ONE documentation for further information.

Natural Single Point of Development 9



What is Natural Single Point of Development?

® Natural Engineer
Natural Engineer is a versatile maintenance and reengineering tool that cuts costs and enhances
productivity. It enables you to respond faster to technological developments such as the Web,
while fully leveraging prior investment in Natural applications and in proven business logic.

You can use the optional Natural ONE component Natural Engineer to convert Natural objects
containing INPUT statements for use with Natural for Ajax pages. See the Natural ONE document-
ation for further information.

If you are working with Natural Studio, you can use the Metrics and XRef Viewing plug-in.

® Natural ISPF (Integrated Structured Programming Facility)
Natural ISPF is Software AG's application development tool for the building, testing and
maintenance of applications throughout their lifecycle.

You can use the optional NaturalONE component Mainframe Tools to access and manipulate
objects stored on a mainframe from Eclipse. The objects are displayed in a tree structure and
can be browsed and edited.

If you are working with Natural Studio, you can use the Mainframe Navigation plug-in.

Powerful Features

Natural's Single Point of Development approach is Software AG's response to the increasing demand
for a state-of-the-art development workstation for building, testing and maintaining all Natural
applications throughout their lifecycle and across all supported platforms. It offers the following
powerful features:

* NaturalONE or Natural Studio - a unified consistent interface

With the integrated development environment (IDE) of NaturalONE or Natural Studio, software
engineers can perform all the necessary development tasks, including file manipulation, editing,
compiling, debugging, and cross referencing. Developers can manipulate (move, copy) program
objects, wherever those objects are located. Natural source files are transparently retrieved from
and saved to the target environment, and edited in the IDE. Compiles are initiated from the IDE
by submitting commands to the target environment. The application executes on the target en-
vironment with debugging controlled from the IDE.

® Client/server architecture enables one single remote development environment for all plat-
forms
Natural Single Point of Development is based on a client/server concept. On the client side,
NaturalONE or Natural Studio offers a single, uniform view for all Natural developers. The
graphical user interface is the basis for a single, uniform working environment for all platforms
(mainframe, mid-range and Windows computer systems) supported by Natural. For more details,
refer to Natural SPoD Architecture.

10 Natural Single Point of Development



What is Natural Single Point of Development?

® Full remote development access after mapping to the target environment

For remote development, Natural ONE or Natural Studio can be enabled to interact with a de-
velopment server that can be located on a single or multiple, homogeneous or heterogeneous
mainframe or mid-range computer systems. Once you have mapped your target environment
in the client, you have a set of convenient and effective tools at hand that enable you to perform
all development tasks. You can use the functionality to the extent it is available there. To prevent
concurrent updates when you work directly in the target environment, the object under work
is locked. For more details, refer to Remote Development Interface.

® Application conceptin Natural for Windows giving a logical view to distributed applications
To meet the requirements of a new, distributed application development scenario, an application
concept is available with Natural for Windows which provides a logical view of Natural and
future objects on the various sites where they are developed and used. On the workstation
screen, this is complemented by an application workspace which shows all distributed objects
of an application in a tree structure. For more details, refer to SPoD Application Concept in
Natural Studio.

| Note: The SPoD application concept is not supported by NaturalONE.

* Remote development server file
To cope with the requirements of the distributed application concept, a central data dictionary
file is available. This file has the same structure as the well-known Natural system file FDIC. The
central data dictionary file stores the information where the objects linked to an application are
located and which objects are locked.

® Web development with Natural's enhanced XML capabilities
Several Software AG development components, which are included in or are complementary
to the SPoD environment, specifically take advantage of the XML standard. These include the
DBMS layer, with Tamino XML Server, and the Natural language itself, with XML Toolkit for
Natural. In addition, Natural supports XML-supplied XSL/stylesheet-based presentation clients
for Web browsers.

Natural Single Point of Development "
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3 Remote Development Interface

The primary goal of the Single Point of Development (SPoD) approach is to provide a development
interface that enables software engineers to develop Natural applications for any platform using
only one integrated development environment (IDE) of choice: NaturalONE, or Natural for Win-
dows which includes Natural Studio.

The essential features are:

Remote File Manipulation
You can manipulate (for example, move, copy) program objects, regardless of location.

Remote Editing

You can retrieve Natural source files transparently from the target environment, edit them at
your workstation and then save them to the target environment. The GUI supported dialogs of
the editors provide significant advantages over the character-based editors.

Remote Compiling
You initiate the compilation process from your workstation by issuing commands to the target
environment.

Remote Debugging
The debugger available with the IDE can be used to debug applications which execute in a target
environment that can be located on the same system or in Natural remote environments.

Object Locking
When you access a remote development server, an object locking mechanism prevents concurrent
updates. Locking information is kept in the development server file.

Output

Maintenance of character-based applications often involves testing output to terminals. During
debugging from the IDE, a terminal emulation window or a window of the Natural Web I/O
Interface appears automatically for that purpose. This feature is also available when you are
using a utility with a character user interface.

13



Remote Development Interface

| Note: Natural Development Server for Windows supports only the Natural Web I/O In-
terface.

The Natural Web I/O Interface is able to display information which contains Unicode characters.
The terminal emulation window is not Unicode-enabled. The window which will appear at
your site depends on the parameters which have been set on the Natural development server.

14 Natural Single Point of Development



4 SPoD Application Concept in Natural Studio

= Conventional Approach
= SPoD Approach .........
= Base Application ........
= Compound Application
= Application Workspace
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SPoD Application Concept in Natural Studio

Conventional Approach

A conventional Natural application consists of a collection of Natural and non-Natural objects.
Together, they form a functional unit which covers the business logic for a particular business
problem. An application consists of a set of libraries and their Natural objects. It is possible that
one part of the library belongs to one application while another part belongs to another (different)
application.

SPoD Approach

| Note: The SPoD application concept is not supported by NaturalONE.

With Natural for Windows, the term “Natural application” has been introduced. A Natural applic-
ation provides a logical view of Natural and non-Natural objects (such as job control files) as well
as DDMs. A Natural application does not contain the objects, but it is a collection of links to Nat-
ural objects or “sub-applications” describing where the objects are stored. Natural objects or “sub-
applications” can be linked to several applications.

The following types of Natural applications exist:

® base application
® compound application

The space where the applications are maintained and displayed in Natural Studio is called the
“application workspace”.

The application definitions are stored in the development server file (FDIC). When working with
applications which are spread across different development servers, for example, for building up
a compound application, it is mandatory to use a unique development server file for all applications
and the application server session.

| Note: This application concept is supported by Predict.

16 Natural Single Point of Development



SPoD Application Concept in Natural Studio

Some Arguments for Using the Term Natural Application

The following arguments may give you an idea why you should use the term “Natural application”
and the concept that stands behind it:

® It groups the content of your libraries in a logical order based on the different applications you
are maintaining that can be displayed in parallel to the library structure without using an addi-
tional tool.

= It focuses your view on the number of objects of a library you intend to work on. You need no
longer navigate through all Natural objects located in one library, because you can edit the objects
directly from the application workspace.

® It reduces the maintenance effort, because you are able to link all objects of different libraries
to the application, especially those located in the steplibs.

= It gives you the opportunity to group an application into different “sub-applications” where
each “sub-application” can be assigned to a member of the development team that is responsible
for its development or maintenance.

* Thinking of client/server architecture, you are able to group your application into different “sub-
applications”, and each “sub-applications” can be stored on a different platform at application
runtime.

Base Application

A base application is defined as a set of Natural object links. The associated Natural objects pertain
to one specific Natural Development Server and are all located on the same FUSER system file.

Natural Single Point of Development 17



SPoD Application Concept in Natural Studio

Base Application

Library1
[ |
Prog1
Progn
LioraryM
T
ProgM1
ProgMn

Base Application Structure (Example)

The following information is stored for a base application:

Name of the application
Description of the application (textual information only)

Name and port ID of the Natural development server where the linked objects reside, that is,
the application environment

Profile for the application environment
Entry points describing the start objects of your application

Identification of each object linked

Compound Application

A compound application enables the application developer to combine several base applications.
It is defined as a set of links to these base applications.

The base applications involved in a compound application can be spread across different FUSER
system files or different development servers. Each base application may have a different parameter
setting.

18
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SPoD Application Concept in Natural Studio

Compound Application

BaseApplication
I

Library1 to n
|

Progl to n
Server 1

— BasefpplicationM
|

Library1 to n
|

Progl ton
Server 2

Compound Application Structure (Example)

The following information is stored for a compound application:

® Name of the application
® Description of the application

* Identification of each base application linked

Application Workspace

The application workspace is an area on the Natural Studio screen (similar to Natural Studio's
library workspace) where all known applications and their objects are shown in a view which
complements the existing logical, flat and file views and displays a tree structure comprising all
program objects belonging to an application, see example below.

Natural Single Point of Development 19



SPoD Application Concept in Natural Studio

Application Workspace | =

£1-Fg SPODAPPLL
Elca User Libranies
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o Text
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Natural SPoD Architecture

This chapter describes the system architecture of Natural's Single Point of Development (SPoD).

SPoD allows centralized application development from a single integrated development environ-
ment (IDE). You can use NaturalONE or Natural Studio to develop and test Natural applications
in a remote environment located on a mainframe, UNIX, OpenVMS or Windows platform.

SPoD is based on a client/server concept that allows one single remote development environment
for all platforms. The graphic below illustrates this concept and the major components of the SPoD
architecture:

Development Client Development Client
MaturalONE Matural Studio
Plug-in Flug-in
Plug-in Plug-in
‘Windows or Linux Windows
TCFRIP

Add-on Product
Developmeant Server

Natural Add-on Product

Development
Server

and Add-on Product

Matural

Mainframe, UNLX,
Windows or OpenVviMS
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Natural SPoD Architecture

Development Client

NaturalONE or Natural for Windows which includes Natural Studio serves as the remote devel-
opment desktop client for the target environment on a mainframe, UNIX, OpenVMS or Windows
platform. This is the central workstation where users design applications. All Natural-related

functions required for remote development can be performed from within the development client.

Difference between Natural ONE and Natural Studio

NaturalONE is based on the open source project Eclipse. Eclipse tools mainly work on a workspace,
which is a specific place in the file system where the application data is stored. This is the major
difference between Natural Studio and NaturalONE. For Natural, this fact requires that applications
are offloaded to the workspace and are versioned in a version control system. The local NaturalONE
parser provides independence from the Natural server during source development and supports
the developer with content assist; context-sensitive source code completion is available upon request.
Furthermore, the Natural builder knows the dependencies between the Natural objects and
automatically recatalogs (very similar to the Natural system command CATALL) the dependent
Natural objects in case of a server update.

NaturalONE enables Natural developers to work in parallel on the same Natural application.
Using the versioning capabilities, the migration of the different source changes from several de-
velopers are done using the version control system. Owing to the possibility to work in parallel,
you gain productivity during the development process.

NaturalONE stores the Natural sources in the workspace. For execution or debugging of the ap-
plication, a Natural server is required on which the Natural object is executed.

Natural Studio is “just” a graphical user interface for the different Natural servers. Any changes
done in the editor are stored directly on the Natural server. All involved developers can see these
changes because there is no separate development environment, unless it has been set up by the
developers. If you are used to work with Natural Studio and SPoD, you will find comparable
functionality in NaturalONE (with the Natural Server view). However, in order to make the most
of NaturalONE, it is strongly recommended that you offload your application into the Eclipse
workspace as mentioned above.

Working in parallel with NaturalONE and Natural Studio

Since NaturalONE and Natural Studio make use of the SPoD concept, it is possible that users of
both application development environments can work on the same Natural server in parallel.
Locking of the sources on the Natural server prevents that one user overwrites source changes
made by another user. However, it is recommended that you work with only one development
environment (either Natural ONE or Natural Studio) with one FUSER.

Natural Single Point of Development 23



Natural SPoD Architecture

Due to the fact that Natural ONE and Natural Studio have the same directory structure in the file
system, it is possible to import a Natural Studio project which is under the control of a version
control system (CVS or SVN) into the NaturalONE workspace.

For detailed information on NaturalONE, see the NaturalONE documentation which is available
separately.

Development Server

Natural Development Server (NDV) allows remote development for the Natural installation in
the target environment on a mainframe, UNIX, OpenVMS or Windows platform. Natural on the
target platform plus Natural Development Server constitute the development server environment.

Add-on Product

NaturalONE and Natural Studio provide plug-ins that can be used to integrate one or more Nat-
ural add-on products (for example, Predict) into a SPoD environment. The installation of the re-
spective add-on product(s) in the development server environment is a prerequisite for the plug-
ins.

Security

You can use Natural Security to protect the Natural Development Server environment, and - when
you are working with Natural Studio - Natural base applications and compound applications. For
further information, refer to the Natural Security documentation which is part of the Natural doc-
umentation for the different platforms.
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Natural SPoD Frequently Asked Questions

This chapter contains frequently asked questions regarding Natural Single Point of Development.

Which versions of Natural and the related products are required to use the
full set of Natural Studio functionality?

For creating and operating a Natural remote development environment, or for using additional
SPoD functionality, the products as described under hittp://documentation.softwareag.com/natur-
al/spod_prereq/prereq.htm (Empower login required) are required.

Can Natural objects of previous versions be used in a SPoD environment?

Yes, Natural objects of previous versions can be used in a SPoD environment without migration.

Do | need Predict?

No, although the SPoD approach requires a development server file which is a central Natural
system file structured like the FDIC file. This does not mean that Predict is a prerequisite for remote
development, although Predict supports the SPoD application concept. Predict is needed to use
the XRef functionality, the object description and/or the schema generation functionality.

Can | use Predict Case in a SPoD environment?

Predict Case (PCA) has not been integrated into the SPoD concept. With Natural Studio, it can be
invoked like any other mainframe Natural application via the terminal emulation feature of the
remote development environment. However, Predict Case objects will not appear in the remote
development tree view.

What is the difference between the SPoD application concept and the earlier
application shell concept in Natural for Windows?

The earlier Natural application shell was used with the frame gallery for developing, administering,
and monitoring application solutions. Together, they provided an infrastructure in which numerous
standards were defined and were implemented in the form of reuseable components, such as
dialogs and procedures.
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Natural SPoD Frequently Asked Questions

The application concept introduced with Natural Single Point of Development is intended to address
the structure of customer solutions so as to get a new logical view on the solution which is not
limited by the boundaries of the Natural libraries.
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I I I SPoD Administration Policies and Procedures

This part provides information which is required to be able to administer a Natural development
environment that is based on the Natural Single Point of Development (SPoD) approach.

It is primarily aimed at those who are responsible for setting up an effective working environment
for Natural application developers.

It covers the following topics:
Installing Natural Single Point of Development

Configuring Natural Single Point of Development
APIs for the SPoD Utility Protocol
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7 Installing Natural Single Point of Development

= Prerequisites ............

= |nstallation Procedure
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Installing Natural Single Point of Development

This chapter summarizes the prerequisites and the installation steps that are necessary to create
a Natural Single Point of Development environment that uses NaturalONE or Natural Studio as
a development client and Natural Development Server running under the operating system z/OS
(Batch or Com-plete), z/VSE, BS2000/OSD, Windows, UNIX or OpenVMS as a remote development
server.

Prerequisites

Products Required or Involved

When using the Natural for Windows (Natural Studio) development client, see Prerequisites for
Natural Single Point of Development at http://documentation.softwareag.com/natural/spod_pre-
req/prereq.htm (Empower login required) for detailed information on the supported products.

When using NaturalONE as the development client, see your NaturalONE documentation for
detailed information on the supported products.

Technical Requirements

A wide-area network (WAN) environment is required with a minimum transmission rate of 100
Mbit or higher.

Installation Procedure

Installing the products that make up Natural Single Point of Development comprises the following
general installation steps (as applicable):

= |nstalling NaturalONE

= |nstalling Natural for Windows (Natural Studio)
= |nstalling Natural for Mainframes

= |nstalling Natural for UNIX

= |nstalling Natural for OpenVMS
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Installing Natural Single Point of Development

= |nstalling the Natural Development Server
Installing NaturalONE
Refer to the Installation documentation for Natural ONE.
Installing Natural for Windows (Natural Studio)
Refer to the Installation documentation for Natural for Windows.
Installing Natural for Mainframes

Refer to the relevant installation documentation for Natural for Mainframes:

= Installation for z/OS
= Installation for BS2000/OSD
* Installation for z/VSE

For background information on the automated installation of Software AG products, see also
Concepts of System Maintenance Aid in the System Maintenance Aid documentation.

Installing Natural for UNIX

Refer to the Installation documentation for Natural for UNIX.
Installing Natural for OpenVMS

Refer to the Installation documentation for Natural for OpenVMS.
Installing the Natural Development Server

Refer to the relevant section of the Natural Development Server installation instructions:

= Installing the Natural Development Server on z/OS (Batch) and,

= if CICS is used as TP monitor, Installing the Natural Development Server CICS Adapter

® if IMS TM is used as TP monitor, Installing the Natural Development Server IMS Adapter
® Installing the Natural Development Server on z/OS (Com-plete)

® Installing the Natural Development Server under SMARTS on z/VSE and, if CICS is used as TP
monitor, Installing the Natural Development Server CICS Adapter

® Installing the Natural Development Server under SMARTS on BS2000/OSD
® Installing the Natural Development Server under Windows

= Installing the Natural Development Server under UNIX
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® Installing the Natural Development Server under OpenVMS
Defining a Natural Development Server File

The Natural Development Server File (FDIC) is used as a central dictionary file for storing Natural
applications and the links to objects making up an application. It also holds object locking inform-
ation. This information is not bound to certain groups of application developers, but has an impact
on the entire application development of an enterprise. Therefore, this file should be available
only once, to ensure that the application definitions and locking states are kept consistent.

The following information applies to mainframe environments only:

» To ensure the use of one single Natural development file

1  Setthe NTDYNP parameter in the default Natural parameter file NATPARM to OFF:

= Specify NTDYNP OFF, if you want to disallow overwriting of all dynamic parameters

" orspecify NTDYNP OFF, FDIC, if you want to disallow overwriting of the Natural development
server file only.

2 Disallow any changes to profiles by the end user.
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8 Configuring Natural Single Point of Development

= Configuring NaturalONE ..........................
= Configuring Natural for Windows ................
= Configuring Natural for Mainframes .............
= Configuring Natural for UNIX ....................
= Configuring Natural for OpenVMS ...............

= Configuring the Natural Development Server
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Configuring Natural Single Point of Development

This chapter provides an overview of the configuration facilities that exist for the individual
products involved in a Natural Single Point of Development environment. References are given
to documents where the relevant configuration functions or parameters are described.

Configuring NaturalONE

After the installation, NaturalONE is preconfigured out of the box.

Configuring Natural for Windows

Natural for Windows offers configuration possibilities which are documented in the Configuration
Utility documentation of Natural for Windows. For details, refer to:
® Local Configuration File
® Buffer Pool Assignments
® Installation Assignments
® Global Configuration File
® Database Management System Assignments
® Dictionary Server Assignments
® Printer Profiles
" System Files

See also the Parameter Reference documentation for Natural for Windows.

Configuring Natural for Mainframes

Information on how to configure Natural in a mainframe environment is primarily contained in
the Operations and Parameter Reference documentation for Natural for Mainframes. The following
topics are relevant:

® Profile Parameter Usage

® Natural Parameter Hierarchy

" Assignment of Parameter Values

Profile Parameters Grouped by Function
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Configuring Natural for UNIX

Information on how to configure Natural in a UNIX environment is primarily contained in the
Operations and Parameter Reference documentation for Natural for UNIX. The following topics are
relevant:

® Profile Parameters

® Natural Buffer Pool

Configuring Natural for OpenVMS

Information on how to configure Natural in an OpenVMS environment is primarily contained in
the Operations and Parameter Reference documentation for Natural for OpenVMS. The following
topics are relevant:

= Profile Parameters

® Natural Buffer Pool

Configuring the Natural Development Server

For details on how to configure the Natural Development Server, refer to Confiquring the Natural
Development Server in the corresponding Natural Development Server documentation.
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9 APlIs for the SPoD Utility Protocol

= APIs for Natural on the Client ..

= APIs for Natural on the Server

= Example Application .............
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APIs for the SPoD Utility Protocol

With the SPoD utility protocol it is possible to invoke a program on the Natural Development
Server, send alphanumeric data to the server (up to a maximum of 5000 bytes) and receive alpha-
numeric data from the server (up to a maximum of 5000 bytes). This works similar to a Natural
RPC call. The server program(s) can communicate with the client program(s), i.e. data can be ex-
changed with the client when the server program is still running.

A\  Important: The programs running on the Natural Development Server must not perform

any screen I/O operations. This would result in a break down of the server connection.

Two APIs and two example programs are provided in library SYSEXNDC of Natural for Windows
installed on the client side.

The corresponding APIs and example programs on the server side are provided in the library
SYSEXNDV of the Natural Development Server.

The APIs can be used together with the SPoD utility protocol.

APIs for Natural on the Client

For the client programs the following APIs and examples are provided in library SYSEXNDC of
Natural for Windows:

NDVCOO1N|This subprogram returns the status of a connection to the remote Natural Development Server
environment. It can be used to check whether it is possible to connect to a server application.

NDVCO02N|This subprogram provides access to a connection to the remote Natural Development Server
environment. It invokes a program on the server. The library and program name are part of the
data sent to the server.

NDVCO01P|This example explains how to design a user-defined program to call subprogram NDVCOOIN. It
also contains a description of the parameters of subprogram NDVCOOIN.

NDVCO002P|This example explains how to design a user-defined program to call subprogram NDVCO02N. It
also contains a description of the parameters of subprogram NDVCOO02N.

APIs for Natural on the Server

On the server, the following APIs and examples are provided in the library SYSEXNDV of the Nat-
ural Development Server. The description of the parameters can be found in the text member
A-README in the same library.
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NDVSOOIN

This subprogram, which must be called when a server program is started, is used for the
initialization of the server environment. It sets the steplibs SYSLIB and SYSLIBS in the user
steplib table and checks if the trace function is active.

NDVSOO0ZN

This subprogram should be called at the end of a server program before the END or STOP
instruction for cleanup reasons. It deletes the steplibs SYSLIB and SYSLIBS from the user steplib
table.

NDVSOO3N

Natural subprogram that enables you to exchange data with the client program.

NDVSOO04N

Natural subprogram that enables you to write trace data into a Natural text member or into the
Natural Development Server log file. This may be helpful during program development and
for error tracing.

Note: On the mainframe, every time a trace message has been written into a Natural text member,
an END TRANSACTION is performed.

Example Application

A small example application that illustrates how to use the different APIs is provided with the
Natural Development Server.

The client program is provided in the library SYSEXNDC of Natural for Windows.

The server programs are provided in the library SYSEXNDV of the Natural Development Server.

Client Program in Library SYSEXNDC

For the client side, the following program is provided:

NDVCMAIN

This program checks whether the remote environment is active and enables you to invoke five
different programs on the server side. To activate the program, create a customized user
command as described in the section How to Execute a Program Locally in Natural Studio
When a Remote Environment is Active.

Server Programs in Library SYSEXNDV

For the server side, the following example programs are provided:

NDVSPING

This is an example program for the PING function. It reads the data sent by the client program
and simply returns a filled buffer.

NDVSINTA

This is an example program for the interaction handling. It reads the data sent by the client
program, returns data to the client, and waits for an answer from the client. Depending on the
data sent by the client, it continues sending data or stops processing.

NDVSEMPR

This is an example program that reads the EMPLOYEES file and sends the data to the client. It is
an extension of the interaction handling demonstrated in NDVSINTA.
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NDVSTRCE|This is an example program that enables you to switch the trace facility on or off. The above
mentioned example programs all write trace data if the trace facility is activated.

NDVSWRLG|This is an example program that writes a message into the Natural Development Server log
file.

How to Execute a Program Locally in Natural Studio When a Remote Environment is Active

In order to communicate with a program on the Natural Development Server, a Natural program
or dialog must be executed locally in Natural Studio when you are connected to a remote Natural
Development Server environment (that is, when your current active library is a library on the
Natural Development Server). This can be easily achieved by defining a customized user command
in Natural Studio.

In order to execute NDVCMAIN, your customized user command must contain the following:

LOGON SYSEXNDC; NDVCMAIN

A detailed description on how to create customized user commands is given in the Natural for
Windows documentation under User Commands in the section Customizing Natural Studio of the
Using Natural Studio documentation.
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IV First Steps with Natural Studio

This tutorial provides an introduction to Natural Studio which is part of the Single Point of Devel-

opment (SPoD) concept. It is intended for developers who are not yet familiar with the Windows
version of Natural.

This tutorial is not intended to be a comprehensive description of the full range of possibilities
provided by Natural Studio. Therefore, explanations are kept to a minimum. For detailed inform-
ation, see Using Natural Studio in the Natural for Windows documentation.

It is recommended that you follow the tutorial in the sequence indicated below.

Starting Natural

Customizing the Natural Studio Window
Local and Remote Environment

Issuing Commands

Handling Programs

Locking and Unlocking

Handling Applications
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10 Starting Natural

This tutorial explains how to work with a development server on a mainframe. It assumes the
following:

The development environment of Natural for Windows has been installed.

A development server has been installed on the mainframe. See the corresponding Natural
Development Server documentation.

The dataset NDVvrs. EXPL has been loaded with the utility INPL on the development server. This
dataset contains the sample library SYSSPODA that will be used in this tutorial.

| Note: The terms vrsor v.r.s represent the corresponding product version number,

where v represents the version number (one digit), r the release level (one digit) and s
the system maintenance level (one digit). Example for the above mentioned dataset:
NDVvrs.EXPL.

You have a basic understanding of how to use Microsoft Windows.

You have already read Introducing Natural Single Point of Development.

When Natural is installed, an entry for starting Natural is automatically added to the Windows
Start menu.

» To start Natural

From the Windows Start menu, choose All Programs > Software AG > Tools > Natural n. n.

| Note: The Start menu group name (by default, this is "Software AG") can be changed
during the installation.

Natural Studio, the development environment for Natural, appears. When you start Natural
for the very first time, Natural Studio shows only your local environment containing the library

45



Starting Natural

workspace. When several elements of the Natural Studio window have been activated and
you are currently editing a program, the window may look as follows:

Library Workspace  Menu Bar
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The different environments are explained later in this tutorial.

You can now proceed with the first exercise: Customizing the Natural Studio Window.
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Customizing the Natural Studio Window

Moving and DOCKING WINAOWS .........eviieiiiiii et

Resizing Windows ...

Using Different Views

Displaying Additional TOOIDATS .........coiutiiieiiiiit e
Displaying the CommMaNd LINE .........ccoiiiiiiiiii e
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Customizing the Natural Studio Window

Moving and Docking Windows

Using the mouse, you can drag each dockable window within the Natural Studio window to an-
other position so that it is shown

® at another position within the Natural Studio window, or

® in a window of its own, for example:

Library Workspace @

=2 Local Environment

> Cp [

-Lg System Libraries
4.3 Libraries (30,31)

gy Logical View | — Flat View | gz File View |

You can move the window freely on your screen. You can move it back to the Natural Studio
window (for example, back to its original position) so that it is no longer shown in a window.
This process is called “docking”.

» To enable/disable docking for a window

1 When the library workspace, application workspace or results window is currently docked,
move the mouse pointer to title bar of the window.

When the command line, menu bar or a toolbar is currently docked, move the mouse pointer
to the two lines which are shown with the docked window. For example, when docked hori-
zontally, the two lines are shown as follows to the left of the docked window:

Or:

When the window is currently undocked, move the mouse pointer to the title bar of the
window.

2  Invoke the context menu.
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When a check mark is shown next to Enable docking, the window can be docked. When a
check mark is not shown, the window cannot be docked.

3 If you want to toggle the docking status, choose Enable docking.

Note: When you disable docking for a window which is currently docked, the window

is undocked.

» To undock/dock a window using the mouse

This requires that docking is enabled (see above).

s Double-click the title bar of a docked window, or double-click the two lines which are shown
for specific types of docked windows (see above).

Or:
Double-click the title bar of an undocked window.

When the window is currently docked, it is undocked. When the window is currently un-
docked, it is docked at its previous position.

» To drag a docked window to another position

This requires that docking is enabled (see above).

1 Move the mouse pointer to the title bar of a docked window or to the two lines which are
shown for specific types of docked windows (see above).

2 Press the mouse button and drag the window to another position.

An outline of the window is shown. The outline indicates the position at which the window
can be docked.

3  If you want to prevent docking (that is, if you want to undock the window), press CTRL while
dragging the window.

4  Release the mouse button.
» To drag an undocked window back to the Natural Studio window

This requires that docking is enabled (see above).

1 Move the mouse pointer to title bar of an undocked window.

2 Press the mouse button and drag the window to the position at which you want to dock it.
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An outline of the window is shown. The outline indicates the position at which the window
can be docked.

3  Release the mouse button.

| Note: When you exit Natural Studio, the settings in the View menu as well as position and

size of the Natural Studio window and its subwindows are stored in the Windows registry.
The next time you start Natural Studio, its window is restored as it appeared when you last
used it.

Resizing Windows

You can modify the size of each window within the Natural Studio window.

In this exercise, you will resize the library workspace window which is initially docked within
the Natural Studio window.

» To resize a docked window

1 Move the mouse pointer over the right border of the library workspace window until the
pointer changes, showing two arrows pointing in opposite directions.

Library Workspace alx
=& Local Environment

- Cp IS

Cé Systern Libraries 4k
-3 Libraries (30,31)

E;u Logical View ;, Flat View D;a File: View

2 Click and hold down the mouse button.
3 Drag the mouse to make the window larger or smaller.

4  When the window has the desired size, release the mouse button.
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Using Different Views

The library workspace window provides tabs for different views:

* Logical View
In the logical view, different nodes are provided for user libraries, system libraries and DDMs
(FDIC). The objects in a library are grouped into different folders, according to their types.

Library Workspace NE

=-5) Local Environment -

J:a User Libraries

1S e Livaris

-y SYSAPI

-y SYSBPM

- SYSCP

-0y SYSDDM

-y SYSDICAM

-y SYSEDM

=-{= SYSERR

: {:_j Programs
--D Subprograms
{::\ Subroutines =

|.m

;:. Logical View |: Flat View ;—:; File View

For example, all programs are shown in a folder called "Programs". Thus, if you want to view
the available programs in a library, you must first open the corresponding folder (for example,
by clicking the plus sign next to the folder name). This is not required in the flat view.

* Flat View
In the flat view, different nodes are provided for the Natural parameters: FUSER, FNAT and FDIC.
The objects in a library are displayed without any grouping. However, the object type is always
indicated by the icon next to an object.
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Library Workspace

=&} Local Environment
L@ FUSER
-Ca

-3 SYSAPI
-y SYSBPM
f-y SYSCP

-y SYSDDM
-y SYSDICAM
-y SYSEDM
-5 SYSERR

. 55 ERRCHAR
[ ERRCSETA
..... ‘& ERRGDA

1| . m

| b

" File View

- ,:. Logical View ; Aat View ||:-lII File View |

In the file view, the name of each mapped remote database is shown with database ID and file
number (mapping is explained later in this tutorial). Different folders are provided for each
library (provided that the corresponding objects exist in this library): "Src" contains all Natural
sources, "Gp" contains all generated programs (object code). Folders for other subdirectories
(for example, "Res" for resources or "Err" for error codes) may also be available.

Library Workspace

S

=5 Local Environment

-3y SYSAPI
-y SYSBPM
f-{y SYSCP
w0y SYSDDM
f-y SYSDICAM
-y SYSEDM
o= SYSERR
- = Gp
-3 Res
; --{:j Src
f-{y SYSEXBAT

1 | 1]

l:a Ch\ProgramData'Software AG\Matural
EC& Ch\ProgramData'Software AG\Matural

3

&

ugu Logical View I; Flat View o= File View |

In the different views, icons are shown for the Natural objects. For example:
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This icon is shown for a program.
8 When both source code and a generated program are available for an object, a green dot is displayed
on the icon.

53 When only a generated program is available and no source code, the icon is gray.

| Note: If you want to see more icons for the different object types, expand the node for
SYSMAIN in the logical view and then expand the nodes for the different folders.

When you resize the library workspace window, it may happen that the window is not wide
enough to display all tabs at the bottom. In this case, arrow buttons are provided. To display an-
other view, you can either enlarge the window and select the corresponding tab, or you can use
an arrow button to display the corresponding view.

Fl 1] I

Y . r
pog Logical View | — Flat View | + | »

Displaying Additional Toolbars

Natural Studio provides several toolbars. Only a few of them are initially shown in the Natural
Studio window.

In this exercise, you will activate the Tools toolbar which provides buttons for commands that
you will use later in this tutorial:

INEEEETINF IR 2

G4
Cl
=

&l

] Note: You can undock and dock each toolbar that is shown in the Natural Studio window

as described above for the library workspace window.

» To display the Tools toolbar

1  From the Tools menu, choose Customize.

The Customize dialog box appears.

2 Choose the Toolbars tab.
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N

Commands | Toaolbars | Keyboard I Izer Cnmmands|

Toolbars:

[ Compiler Options

|Data Area Edtor Fields Show ToolTips

Egz[l}t; P'Er;: Editor Insert With Shortcut Keys
ar

Debug

[ Dialog Editor

[ Dialog Editor Cortrol

[ | Dialog Editor Insert

[ | Dialog Editor Options

[ | Dialog Selection

7l CAa

Toolbar Mame:

3 To proceed to the bottom of the list box, use the scroll bar or the down arrow.

Initially, the Tools check box is not selected. This means that the Tools toolbar is currently
not shown in the Natural Studio window.

4  Select the Tools check box so that a check mark is shown in the box.

Toolbars:

[ Librany -
[[|Map Editar

[|Map Editor Field

["|Map Editor Ingert

Object

[| Program Editor

[| Program Editor Options

[| Program Editor View

[ Window

Each toolbar that you activate is immediately shown in the Natural Studio window. It is always
shown in its last state (either docked or undocked).

5  Choose the Close button.
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Displaying the Command Line

You can issue all Natural commands directly from the command line. An example is given later
in this tutorial.

Command: w Librane: SYSTEM Environment: Local

| Note: You can undock and dock the command line as described above for the library

workspace window.

Initially, the command line is not shown.

» To toggle command line display

s From the View menu, choose Command Line.
Or:
Press ALT+3.

When the command line is displayed in the Natural Studio window, a check mark is shown
next to the Command Line command.

You can now proceed with the next exercise: Local and Remote Environment.
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Local and Remote Environment

A Natural development environment contains all application components such as parameter
modules, system files and buffer pool.

Checking the Environment

SPoD supports the following types of environment:

® local environment on a workstation (this is also the runtime environment of Natural Studio)

" remote environment on a development server

You can check which of these two environments is currently active. The active environment is al-
ways indicated in the command line, next to the Command drop-down list box. When the command
line is not shown, you can display it as described previously in Displaying the Command Line.

In the example below, the local environment is active and you are currently logged on the the
library SYSTEM.

Command: » Librany: SYSTEM Environment: Local

All commands that you issue are always applied to the active environment. When you edit a
Natural object, the corresponding editor is invoked and the object is taken from the active envir-
onment. When you execute an object, it is executed in the active environment.

Only one environment can be active at one point in time.

Connecting to a Development Server for the First Time

In order to perform remote development, you have to activate a remote Natural environment.
You do this by connecting to the appropriate Natural development server. Each Natural develop-
ment server provides all remote services (such as access or update) for a specific FUSER system
file.

If you want to connect to a development server for the very first time, you have to map it as de-
scribed below. Once you have connected to a development server, a node for this development
server session is automatically shown in the tree the next time you invoke Natural Studio.

If you do not know the name and port number for your development server, ask your administrator
before proceeding with the next exercise.
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| Note: Itis possible to map the same development server more than once, for example, if

you want to have development server sessions with different session parameters. To switch
to another session, you simply select the corresponding node in your library workspace.

» To connect (map) to a development server

1 From the Tools menu, choose Map > Environment.
Or:

Use the following toolbar button:

dl

The Map Environment dialog box appears.

Map Environment Iﬁ

Server

Host name:

Server port:

Ervironment name:

Startup
Session parameters:
User ID: NATURAL
Pazzword:
| ok || Canced || Hep |

2 In the Host name text box, enter the name of the development server.
3 Inthe Server port text box, enter the TCP/IP port number of the development server.

4  Optionally. In the Environment name text box, enter the name that is to appear in the tree
(for example, "My Mainframe"). If you leave this text box blank, a combination of server name
and port number is shown in the tree.

5 If dynamic parameters are required for your development server, specify them in the Session
parameters text box. Otherwise, leave this text box blank.

Natural Single Point of Development 59



Local and Remote Environment

6  Your user ID is automatically provided. If you want to map the development server using a
different user ID, specify it in the User ID text box. This is useful, for example, when Natural
Security is active on the development server and administrator rights are to be used.

7 If Natural Security is installed on the development server, specify the required password in
the Password text box. Otherwise, leave this text box blank.

8  Choose the OK button.
When the connection has been established, all libraries (according to the security profile) for

this session are shown in your library workspace. You are automatically logged on to your
default library.

The command line now shows the name of the library that is currently selected in the tree
and the name of the active environment (i.e. the name you specified for the development
server).

Connecting to a Previously Mapped Development Server

Once you have connected to a development server, its name is shown as a node in the tree of your
library workspace.

Library Workspace NES
=2 Local Environment

+% User Libraries

+l:é Systern Libraries

- -3 Libraries (30,31)

Ty i

n;: Logical View ,;, Flat View n;a File "u"lewl

You will now learn how to disconnect a development server and how to connect it again.

» To disconnect a connected development server

1  In the library workspace, select the node for a connected development server.

2 From the Tools menu, choose Disconnect.

Or:
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Invoke the context menu and choose Disconnect.
Or:

When the Tools toolbar is shown, choose the following toolbar button.

g

4

When a development server has been disconnected, its state is shown as follows in the tree:

e | Myhainframe Disconnected

» To connect a disconnected development server

1 Inthe library workspace, select the node for a disconnected development server.

2 From the Tools menu, choose Connect.
Or:
Invoke the context menu and choose Connect.
Or:

When the Tools toolbar is shown, choose the following toolbar button.

LI L]
-4

The Map Environment dialog box appears. It shows the information that you have provided
when you have mapped the development server.

3  Ifrequired, specify the Natural Security password in the Password text box. Otherwise, leave
this text box blank.

You need not specify any other information.

4  Choose the OK button.

When the connection has been established, all libraries (according to the security profile) for
this session are shown in your library workspace. You are automatically logged on to your
default library.

Note: When you invoke Natural Studio, a Map Environment dialog box appears for each

development server which was active (that is: connected) when you terminated Natural
Studio. You can then decide whether you want to connect to this development server again.
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Mapping versus Connecting an Environment

A remote environment is mapped, if the environment is shown in the tree. A remote environment
is connected if an appropriate session on the server exists. The Map > Environment command
automatically includes a Connect command.

It is possible to remove a development server from the tree: Select the server, invoke the context
menu and choose the Unmap command. The Unmap command automatically includes a Disconnect
command. If the development server is still connected when unmapping it, the running session
is shut down. All editor windows that have been opened for this server session are closed.

Connected environments can be disconnected, and disconnected environments can be connected.

Logging on to a Library

You will now log on to the library SYSSPODA which contains the objects that will be used in this
tutorial.

» Tolog on to a library

1  Make sure that the logical view is active in your library workspace.

2 Under the node for the development server session that you have just mapped, use the plus
sign next to the node "System Libraries" to expand the tree.

The system libraries are now listed.

Library Workspace 2|
+- 8 Local Environment -
_ﬁ MyMainframe

+% User Libraries

B e Livaries

+{:3 SYSAAF

+1:] SYSACF

+l:] SYSADA

4.y SYSAER

+{:3 SYSAFP

+1:] SYSAQS

-0 SYSAQSU

-y SYSAPI b

n;: Logical View |; Flat View u;a File View
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3 Scroll down the list until the library SYSSPODA is shown in the tree.

4 To log on to the library, simply select the library name SYSSPODA.

The status line at the bottom of the Natural Studio window informs you that this operation
has been sent to the server.

5 To display the contents of the library, use the plus sign next to the library name SYSSPODA to
expand the tree.

You can now proceed with the next exercise: Issuing Commands.
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Natural Studio commands are often issued via context menus as explained in this section. Several
important context menus are shown in this section, and copying and moving via drag-and-drop
is explained.

Natural Studio also provides a command line in which you can directly enter Natural system
commands. The prerequisite is that a certain logical context is given. For example, the SAVE com-
mand can only be executed when a source is currently shown in the editor.

A graphical user interface is not provided for all system commands that are available in a remote
development environment. When you issue such a command in the command line, terminal
emulation will be started in a separate window, showing the corresponding character screen. You
can then work in the same way as, for example, on the mainframe.

Certain system commands (for example, the mainframe command EDT) are not available in Natural
Studio and can therefore not be executed from the command line. See also the section SPoD-Specific
Limitations and Considerations in your Natural Development Server documentation.

For further information on system commands, refer to Natural's System Commands documentation.

Context Menus

Context menus are invoked using either the right mouse button or by pressing SHIFT+F10. The
commands provided in the context menu depend on the object or the position within the Natural
Studio window that has been selected.

. Note: The menubar at the top of the Natural Studio window can be customized. Thus when

a specific menu is not shown in the menu bar, you can still issue the commands that apply
to the selected object from the context menu.

When you select an element in a tree and invoke the context menu, all valid commands for this
element are shown.

® The following example shows a context menu that has been invoked for a selected a Natural
object.
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Library Workspace afx
- SYSSPODA -
== Programs
= MEM ﬁr Open Ctrl+ 0O
& paM 5 List
2 i
E PRO @ Catalog
&8 PROX
E:Ela PROK %I Stﬂ'H Ctrl+T
(-2 Subprog L& Execute
#-g Copycog i Debug Ctrl+F7
i3 Tod ey Find Objects
-0 SYSSPODK
-3 SYS5PT Rename F2
,; Logical View ; Flat Delete
Command: clﬁl:- Cut Ctrl+X
Copy Ctrl+C
e P Paste Ctrl+V
A= Print Ctrl+P
Properties Alt+Enter

" A different context menu is shown when you select a library. For example:

Library Workspace P
Bl svssPops -
25 Prog g Open Ctrl+ 0
E Mew Source »
E% Mew Resource »
{58 | (3§ Catal
E gy Find Objects
& Sub Display Filter...
I3 Cop Refresh F5
I Ted
{7y SVSSPO Rename F2
- Svsspy|  Delete
oo Logical View I; & Cut Ctrl+X
Copy Ctrl+C
Command: E, Paste Ctrl+W
e ] Properties Alt+Enter
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When you click any other position outside the library workspace with the right mouse button,
different commands are shown in the context menu.

® The following example shows a context menu that has been invoked by selecting the menu bar
or the workspace with the right mouse button:

Object View lerarj.r Debua  Tools Helo

5e ™ :O: |_ Library Workspace Alt+1
oY Application Workspace Alt+2

& cF | ﬂ|_ LCommand Line Alt+3

Li 1hHF Lespace |T Status Bar Alt+4

T e Results Alt+5
= SYSSPODA =

ﬁr - Debugger Alt+b
=- & Prograt

R MAY Object

-5 ’:‘GEF v Edit

% PRC |7 Tools

E% PRO Library

B8 PRC v Debug

-y Subpro Window

- Copycd Compiler Options
-0 Ted
-7 SYS5P 00K

Customize...

" A different context menu is shown in a program editor window. For example:
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ra

MAINPGM [SYSSPODA - MyMainframe] - Program =R ==
=

# program MATHNPGEM for tutorial library SPODLIE

ENT)

Undo Ctrl+Z
Redao Ctrl+Y
Cut Ctrl+X ]
Copy Ctrl+C
i Paste Ctrl+W
. Delete -
N« b
i Find... Ctrl+F
% Find Next F3
ﬁ Replace... Ctrl+H
ﬂ Replace Mext Ctrl+F3
Incremental Find Ctrl+]
"1 GoTo.. Ctrl+G
Adyanced »
Expand/Collapse Ctrl+B
M Toggle Breakpoint 3]
Open Ctrl+0O
List

| Note: When a toolbar button or shortcut key is available, this information is shown in the

context menu. Commands that are dimmed, are currently not available.

Creating User Libraries

You will now create the following user libraries that will be used later in this tutorial:

= SPODLIB
= SPODADD
= SPODTEST

Make sure to create these libraries in an environment in which a Natural development server has
been installed.
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» To create the user libraries

1  Depending on the current view, select one of the following (below the node of the development
server to which you have previously connected):

Logical view: "User Libraries"
Flat view: "FUSER"

File view: the name of the database

2 From the Library menu, choose New.
Or:
Select the node, invoke the context menu and choose New.

A new library with the default name USRNEW is now shown in the tree.

The default name is selected so that you can immediately enter a new name. Any text you
enter automatically deletes the selection.

3 Specify SPODLIB as the name of the library.

4  Press ENTER.
Or:

Click any other position in the library workspace.

5  Create the libraries SPODADD and SPODTEST as described above.

Copying and Moving Objects

With the following exercises, you will

" copy the contents of the system library SYSSPODA to your user library SPODLIB,
® move all subprograms from library SPODLIB to library SPODADD,
" copy the program PGMCHECK from library SPODLIB to library SPODTEST.

These objects will be used later in this tutorial.

Different methods can be used to copy and move objects:
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menu commands (see Copy and Paste in the first exercise in this section)

shortcut keys (see CTRL+C and CTRL+V the first exercise in this section)

“ toolbar buttons (see 52 and B2 in the first exercise in this section)

drag-and-drop (see the last two exercises in this section)

» To copy the contents of the system library SYSSPODA to the user library SPODLIB

Select the system library SYSSPODA.

Invoke the context menu and choose Copy.
Or:

Press CTRL+C.

Or:

Choose the following toolbar button:

You can now paste the contents of the library to your user library.
Scroll to the user library SPODLIB that you have previously created.
Select the user library SPODLIB.

Invoke the context menu and choose Paste.
Or:

Press CTRL+V.

Or:

Choose the following toolbar button:

ic!

All objects from the system library SYSSPODA are now copied to your user library SPODLIB.

» To move all subprograms from the library SPODLIB to the library SPODADD using drag-and-drop

1
2
3

Make sure that the logical view is active.
Click the plus sign next to the library SPODLIB to expand the tree.

Click the "Subprograms" node and hold down the mouse button.
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4  Drag the selected object onto the name of the node SPODADD.

5 Release the mouse button.

All subprograms are now moved to the library SPODADD.

» To copy the program PGMCHECK from the library SPODLIB to the library SPODTEST using drag-and-drop

1  Make sure that the flat view is active. Thus you need not open the folder containing all pro-
grams which is provided in the logical view.

Under the node FUSER, click the plus sign next to the library SPODLIB to expand the tree.
Click the program PGMCHECK and hold down the mouse button.
Hold down CTRL.

Drag the selected object onto the name of the node SPODTEST.

AN U1 =~ W DN

Release the mouse button and then CTRL. The program is now copied to the library SPODTEST.

| Note: When you move an object, you cut it at its original position and paste it at a new

position. To copy an object, press CTRL while dragging. This does not cut the object at its
original position.

Deleting Objects

Since you have copied the program PGMCHECK in the previous exercise, it is available in two libraries.
You will now delete this program from the library SPODLIB.

» To delete the program PGMCHECK from the library SPODLIB

This exercise assumes that the flat view is still active.

1 Under the node for the library SPODLIB, select the program PGMCHECK.

2  Invoke the context menu and choose Delete.

A dialog box appears, asking whether you really want to delete the program.
3 Choose the Yes button to delete the program.

| Note: You can switch off the display of the delete messages. From the Tools menu, choose

Options. In the resulting dialog box, display the Workspace tab, deselect the Display delete
messages check box and choose the OK button.

With all nodes expanded in the flat view, your new libraries should now look as follows:
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Library Workspace N
= SPODADD -
{8 suB1

-flg SUB2

-flg SUB3

{8 suB4

{8 SuBS

—-{F SPODLIE

----- [H copvyal
{8 MAINPGM
-8 MENUL
-5 PGMCHECK
-5 PROGL
-{E8 PROG2
-{E8 PROG3
- TEXT1
- TEXT2
- SPODTEST

oo Logical View = Fat View ||:I;a File View

Cataloging Objects

CATALL is one of the Natural system commands for which a graphical user interface is provided
in Natural Studio.

You will now catalog the objects of the libraries you have just created.

» To catalog all objects in a library

1  Select the library SPODLIB.
2 From the Library menu, choose Cat All.
Or:

Invoke the context menu and choose Cat All.

The Catalog Objects in Library: 7ibraryname dialog box appears.

3  Make sure that the option button Apply action to all sources is selected. Leave the check
boxes in the Object Types group box with their default settings.
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Catalog Objects in Library: spcnnun‘ =

Starting from: | B

Selection Action
(") Apply action to all sources [Eamlog -
= cti ly to existi
@ :ﬂm:s on ony to exising Renumber source lines
Object Types
DDMs (V) Maps
Global Data Areas Generate new map source
Local Data Areas Programs
Parameter Data Areas Dialogs
Subroutines Classes (4)
Subprograms (M) Functions (7)
Helproutines Adapters (8)
| select All | | Clear Al |
ok [ cancel [[ b |
e "
4 Choose the OK button.
A dialog box appears with statistics about the performed command.
Catall Statistics : 5
Objects Cument Comect Failed
[ & 3 1]
Cument object
5  Choose the OK button to close the dialog box.
A dialog box appears, informing you that cataloging was successful.
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Matural I,&J

[

6  Choose the OK button to close the dialog box.

] Notes:

1. If an object could not be cataloged, it is listed in the results window. An error number
(reason why the object could not be cataloged) and an error line (the line position in source
code where the error can be found) is shown in the results window.

2. You can switch off the display of the success messages. From the Tools menu, choose Op-
tions. In the resulting dialog box, make sure that the Workspace tab is shown, deselect the
Display success messages check box and choose the OK button.

7 Repeat the above steps for the libraries SPODADD and SPODTEST.

Displaying the Last Commands

Natural commands can be executed from the drop-down list box of the command line.

Natural Studio saves each character string you enter in the command line for the current session.
The drop-down list box contains your last entries. You can select an entry and press ENTER to execute
it once more.

Command: ll]

LOGON SPODTEST
EDIT PGMCHECK L
SAVE

When you enter the first character of a command that you have previously entered, the correspond-
ing command is automatically copied to the command line. In this case, you just have to press
ENTER to execute it.
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When the mouse pointer is positioned on the command line, you can invoke a context menu. Using
the commands from this context menu, you can, for example, paste a text string into the command
line.

The system command LAST * is an example of a Natural command for which a menu command
is not provided with Natural Studio. In contrast to the commands that you enter in the command
line, the LAST * command displays all system commands in the order in which they were entered
in a dialog box. It considers all Natural commands that were issued during a session: for example,
when you select a library to log on to it, or when you execute a program using a menu command,
toolbar button or shortcut key. Furthermore, it allows you to select several commands to be executed
one after the other (see below).

If the command line is not shown in the Natural Studio window, display it as described previously
in Displaying the Command Line.

» To execute the LAST * command from the command line

1 Enter the following command in the command line and press ENTER:

LAST *

The following dialog box is now shown:

Last Commands Selected Commands

LOGON SYSTEM
LOGON SPODTEST
EDIT PGMCHECEK, Delete

ok, :  Cancel |’ Help

2 On the left, select the first command that you want to execute.

3  Choose the Copy button.

The selected command is now shown on the right.

4  Optionally. Modify the command on the right (for example, specify another library name
with the LOGON command).
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5 Repeat the above steps to copy all commands that you want to execute to the right. The
commands will be executed in the same sequence in which they appear in the list.

6  Choose the OK button to execute all selected commands one after the other.

Listing Objects

You will now list the objects contained in one of the libraries you have previously created. You
can do this in two different ways:

® choose Open from the context menu, or

® enter the LIST * command in the command line

When using the Open command, the content of the window depends on the current view. For
example, in the logical view, all folders are shown, and in the flat view all objects are shown.

When entering LIST *in the command line, all objects of a library are shown. The content of the
resulting window is always the same. The current view is not considered. An advantage of the
LIST command is that you can also specify that only objects starting with a specific letter are shown
(e.g. LIST Px).

» To list all objects in a library with the Open command

1 Make sure that the logical view is active for this exercise.
2 Select the library SPODLIB in the library workspace.

3 Invoke the context menu and choose Open.

The following window appears displaying a list of folders.
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= Object types [SPODLIE - MyMainframe]

(=] O uSa)

Type Mumber
7% Programs 7
{7 Copycodes 1

O Text 2

Size
15038
71

a8

4  Select the "Programs" folder and press ENTER to display its contents.

Or:

Double-click the "Programs" folder.

== |

Source Date

2003-11-1017:09
2003-11-1017:09
2003-11-1017:09
2003-11-1017:09
2003-11-1017:09
2003-11-1017:09

Programs [SPODLIB - MyMainframe]
Mame ¥ Source User ID
NI NATURAL
=8 MENUL MNATURAL
B2 PGMCHECK NATURAL
B PrOGL NATURAL
[EPrROG2 NATURAL
B rrROG3 NATURAL

Source Size Catalog UserID  Catalog Date

57
55
59
73
55
55

NATURAL
NATURAL
NATURAL
NATURAL
NATURAL
NATURAL

2013-07-02 14:58
2013-07-02 14:58
2013-07-0214:58
2013-07-02 14:58
2013-07-0214:58
2013-07-02 14:58

Catalog 5ize  Mode

2868
2868
2868
3056
2868
2868

Structured
Structured
Structured
Structured
Structured
Structured

Encoding

5 To change the display sequence, for example, by the source date, click the column header

Source Date.

An arrow is now shown in this column header indicating the current display sequence.

6  Click the column header Source Date once more.

This toggles between ascending and decending display sequence.

7 Close each of these two windows by choosing the standard close button at the top right of a

window.
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Invoking Terminal Emulation

SYSBPM is a Natural mainframe utility for which a graphical user interface is not provided in Nat-
ural Studio. When you invoke this utility, its character-based mainframe screen is shown either
in a terminal emulation window or in a window of the Web I/O Interface.

Both the terminal emulation window and the Web I/O Interface are used in a remote development
environment to display non-GUI information. This is different from the local environment where
the output is shown in an output window.

The terminal emulation window is not Unicode-enabled. The Web I/O Interface is able to display
information which contains Unicode characters. The window which will appear at your site depends
on the parameters which have been set on the Natural development server.

This section assumes that your remote development environment has been set up to use the ter-
minal emulation window.

| Note: Aslong as the terminal emulation window is active, you cannot work with Natural

Studio.

» Toinvoke the SYSBPM utility in a terminal emulation window

1  Enter the following command in the command line:

SYSBPM

The terminal emulation window appears.
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&1 e I it

| session Edit View Help

Other Functicns

17,014

You can now use the utility in the same way as on the mainframe. Command buttons are
provided for frequently-used PF keys. When they are not shown, you can display them as
described with the following step.

2 From the View menu, choose a PF-key set (for example, PF Keys 1-12) to display the command
buttons for the PF keys.

3  Toexit terminal emulation, issue the EXIT command (either by issuing it in the command line
of the mainframe screen or by pressing the corresponding PF key).

You can now proceed with the next exercise: Handling Programs.
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This chapter shows the most important steps for handling programs with Natural Studio, including
testing and debugging.

For more information, see Program Editor in the Editors documentation of Natural for Windows.

For detailed information on the debugger, see the Debugger documentation of Natural for Windows.

Creating a New Program

You will now create a small program which prompts the user for input and displays this input.
You can create this program in any library that you are allowed to use in the remote development
environment.

» To create a program

1  Select the name of the library in the remote development environment in which you want to
store the new program.

2 From the Object menu, choose New > Program.
Or:
Invoke the context menu and choose New Source > Program.
Or:
Press CTRL+N.
Or:

Choose the following toolbar button:

An empty program editor window appears.
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[

Untitledl - Program EI@
—

m

[ « b

The status bar at the bottom of the Natural Studio window now shows additional information
(line and column in which the cursor is currently positioned and the current size of the pro-
gram). When the program editor window is the active window, all toolbar buttons that apply
to a program are activated. When you move the mouse over a toolbar, tooltips appear. For
example:

g Sl o = e
@yl | e 1| (Checkicr) )

3 Inthe program editor, enter the following code:

DEFINE DATA LOCAL
1 A (A5)
END-DEFINE

INPUT 'Enter' A
DISPLAY A

END

Stowing a Program

You will now stow the program you have just created.

Since it is possible to edit several programs at the same time (this is not possible, for example, on
the mainframe), you have to make sure that the editor window for the program that you want to
stow is the active window. To activate a window, you simply have to select it.
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» To stow a program

1  Make sure that the editor window containing your new program is active.
2 From the Object menu, choose Stow.
Or:
Press CTRLAT.
Or:
Choose the following toolbar button:
The Stow As dialog box appears.
Stow As @
Name: UMTITLED oK
Libraries: [ NATURAL v
Type: [ Program - ] Help
Encoding: |IBMO1140 -
3 Inthe Name text box, enter "DEMO" as the name of your program.
4 To stow the program in the current library, choose the OK button.
If you have not switched off the success messages, a dialog box appears, informing you that
the stow operation was successful. When this dialog box appears, press ENTER to close it.
The new program is now shown in the library workspace. The title bar of the program editor
window now shows the program name, the library in which it is stored, and the environment
name of the current development server.
5  Close the program editor by choosing the standard close button at the top right of the program
editor window.
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Executing a Program

You will now execute your DEMO program.

» To execute a program

1  In the library workspace, select the program DEMO.
2 Invoke the context menu and choose Execute.

Or:

Choose the following toolbar button:

le

The INPUT statement from the above example program invokes either a terminal emulation
window or a window for the Web I/O Interface (depending on the settings on the remote
development server; see the description in the previous section). You are prompted for input.

3 Enter the string "Demo" at the Enter prompt and press ENTER.

The DISPLAY statement from the above example program now shows the string you have just
entered. Example for the terminal emulation window:
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| Session Edit View Help

,
ED Teminl Emistion, O o= =

4  Press ENTER once more.

The example program is ended and the window in which it was shown is automatically closed.

Debugging a Program

You will now debug your DEMO program.

» To debug a program

1 Inthe library workspace, select the program DEMO.

2 From the Debug menu, choose Start.
Or:
Invoke the context menu and choose Debug.

Or:
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Press CTRL+F7.
Or:

Choose the following toolbar button:

i

When the editor for the selected object has not yet been opened, it is opened now and the
debugger is started. The trace position is shown at the first executable source code line (i.e.
the line containing the INPUT statement).

¥

DEMO [NATURAL - MyMainframe] - Program o3| s
DEFINE DATEZ LOCAL ?
1 & (BS)
END-DEFIHMNE

s INPBUT "Enter' A
DISFLAY &
END

m

[ « b

In addition, the following debugger windows are shown:

" Variables Window
This window shows all variables which are available at current state of the program execu-
tion.

® Break- and Watchpoints Window
This window shows all currently defined breakpoints and watchpoints.

* Call Stack Window
This window shows the objects which have been called during the current debugging session
in hierarchical order.

3  From the Debug menu, choose Step Into.
Or:

Press F11.
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Or:

Choose the following toolbar button:
&

The next program step is executed and the trace position is shown at the corresponding source
code line. If this source code line invokes or includes a further Natural object, the debugger
steps into this object and the trace position is shown at the first executable line.

In case of your program, the INPUT statement invokes either a terminal emulation window
or a window for the Web I/O Interface (depending on the settings on the remote development
server; see the description in the previous section).

Enter the string "Demo" at the Enter prompt and press ENTER.
The window in which you have entered the string is closed. In the editor window, the trace

position is now shown in the next executable source code line. In case of your program, this
is the line containing the DISPLAY statement.

Choose the Step Into command repeatedly until the output of the DISPLAY statement is shown
in the window.

To close the window in which the output is shown, press ENTER.

The debugger is terminated automatically if the application ends without an error.

Close the program editor by choosing the standard close button at the top right of the program
editor window.

You can now proceed with the next exercise: Locking and Unlocking.

88
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An object locking mechanism prevents concurrent updates when working with objects that are
stored on a remote development server.

The exercises below demonstrate locking for an object that you are currently modifying in the
program editor of Natural Studio. You will map the same development server once more. When
you then try to open the same object from the new session, a locking message is shown.

For more information, see Object Locking in the Remote Development Using SPoD documentation of
Natural for Windows.

Opening an Object

When you open an object, it is locked for all other users until you close it.

You will now display the Natural code of the DEMO program that you have previously created.

» To open the DEMO program in the logical view

= Inthelibrary workspace, select the program DEMO, invoke the context menu and choose Open.
Or:
In the library workspace, select the program DEMO and press CTRL+O.
Or:
Double-click the name of the DEMO program.

The program is now shown in a program editor window.

¥

DEMO [NATURAL - MyMainframe] - Program | |- B (]
DEFINE DATA LOCAL =
1 & [AL)
END-DEFINE
INPOT 'Enter' A
DISPLAY R
END

-~

m

[ « b

Do not close this program editor window. Leave it open so that locking can be demonstrated
with the next exercise.
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Opening the Same Object from Another Session

When you try to open an object that is currently being modified by another user, the corresponding
lock message is shown. This message tells you which user is currently modifying the object and
the date and time it was locked.

In order to demonstrate locking, you will first map the same development server once more. You
will then try to open the DEMO program from the new session.

» To open the same object from another session

1  From the Tools menu, choose Map > Environment.
Or:

Choose the following toolbar button:

i

The Map Environment dialog box appears.

2 Enter all required information as described under Connecting to a Development Server for
the First Time.

3  Inthe new session, expand the node of the library containing the DEMO program.

4  Double-click the name of the DEMO program.

A lock message is now shown in a dialog box. It shows the ID of the user by whom the object
was locked, and the date and time when the object was locked.

5  Choose the OK button to close the dialog box.

Unlocking Objects

You will now unlock your DEMO program from the session in which it is currently locked (not the
session in which it was opened).

| Note: When Natural Security is active, it is possible that you cannot use certain commands.

Thus, it may be possible that you are not allowed to unlock your own objects.

» To unlock a locked object

1 Inlibrary workspace, select the library containing the locked DEMO program.
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2 From the Tools menu, choose Development Tools > Unlock Objects.

Or:

Choose the following toolbar button:

®

The Unlock Objects dialog box appears. The name of the library that is currently selected in
library workspace is automatically provided.

B UNLOCK [MyMainframe2] - Unlock Objects | (Bl —

Matural Objects | D ocumentation Objects

Objects

Application name: ||

Library: MNATURAL DEID: 10 FMR: 32
Object name: *

Object type: & -

Additionals

Locked by: HATURAL

Locked on: -

k. H Cancel ” Help

Enter application name, blank, or asterizk notation,

3 Choose the OK button (without entering any information).

When locked objects exist, they are shown on the Unlock Objects tab of the results window.

Natural Objects Type Library DBID FMR Locked By Locked On Message
DEMO Program NATURAL 00010 00032 MWATURAL 2013-07-03 11:00:46

[YEY

Results

54 Find Objects | B Cat Al G Unlock Objects

4 In the results window, select the object to be unlocked.
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Invoke the context menu and choose Unlock Objects.

The object is still shown on the Unlock Objects tab. The Message column, however, now in-
dicates that the object has been unlocked.

To hide the results window, choose the standard close button at the top of the results window.
Or:

From the View menu, choose Results.

Or:

Press ALT+5.

When the results window is not shown in the Natural Studio window, no check mark is shown
in the View menu next to the Results command.

Note: You can undock and dock the results window as described previously in this tutorial.

Displaying a List of All Locked Objects

You can display a list of all locked objects for the currently active development server. This includes
the objects of all users in all libraries. You can unlock any object contained in this list.

It is only possible to display and unlock objects from another user in a non-secure environment
(i.e. when Natural Security is not active on the development server). In a secure environment, the
administrator defines which user locks may be unlocked by other users.

» To display all locked objects

1

From the Tools menu, choose Development Tools > Unlock Objects.
Or:

Choose the following toolbar button:

®

The Unlock Objects dialog box appears.

Enter an asterisk in the Library text box.

This will display the locked objects in all libraries.
Enter an asterisk in the Locked by text box.
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This will display the locked objects of all users.

The dialog box should now look as follows:

] UNLOCK [MyMainframe] - Unlock Objects o o0 S

Matural Objects | D ocumnentation I:Il:niec:ts|

Objects

Application name;

Librany: * DEID: 10 FMR: 32

Object namme:

Dbject ype: = -

Additionals
Locked by: *

Locked an: -

k. H Cancel H Help

Enter uzer [0 ar azterizk, notation.

4 Choose the OK button.

The results window is shown again, displaying all locked objects.

5 If you want to delete the Unlock Objects tab from the results window, select an object name
in the first column, invoke the context menu and choose Delete Tab. This tab will automatically
be redisplayed the next time you display locked objects in the results window.

6  Before you continue with the next section, hide the results window as described above.

Moving Folders Containing Locked Objects

Locked objects cannot be moved.

When you try to move a folder containing locked objects to another folder (for example, via drag-
and-drop), a lock message appears.

When you choose the OK button to close the dialog box, another dialog box appears, asking
whether you want to continue the move.
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When you choose the Yes button, all objects except the locked objects are moved.

You can now proceed with the next exercise: Handling Applications.
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Handling Applications

In Natural Studio, an application is a collection of Natural objects and non-Natural objects which
build a functional unit from the business point of view.

There are two types of applications:

* Base Application
A set of Natural objects that are stored in the same user system file (FUSER). You can link objects
of different libraries to a base application.

® Compound Application
You can link several base applications to a compound application. A compound application can
be spread across different hosts.

For detailed information, see SPoD Application Concept.

| Note: The applications that you will create with the exercises below do not run. Their pur-

pose is just to demonstrate the basics for handling applications.

Prerequisites

It is assumed for the following exercises that you have:

" copied the contents of the system library SYSSPODA to your user library SPODLIB,
® moved all subprograms from library SPODLIB to library SPODADD,
" copied the program PGMCHECK from library SPODLIB to library SPODTEST

as described previously in this tutorial.

Displaying the Application Workspace

The application workspace is the area in which all known applications can be displayed. It provides
the same views as the library workspace (logical view, flat view and file view). Your application
workspace is initially empty.

When you start Natural Studio for the first time, your application workspace is not shown. The
exercise below explains how to display it. It is initially displayed at the right of the Natural Studio
window.
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” Object View Library Debug Tools Help
|BErrEr% s FEHREE| S E || snexE|o o
FEFEEEEL I eI
Lbrary Workspace 2l x Application Workspace %
- SPODLIE - =8 Applications
EI@ Programs

- [EB MAINPGM
[E8 MENUL

[E8 PGMCHECK
[E8 PROGL
38 PrROG2
[E8 PROG3
- Copycodes
A copval
[ Text

@ e @

[ TExT2

[E-F SPODTEST

El@ Programs -
o= Logical View | =, Fat View | gay File View

o~ Logical View | =, Fat View | ya File View

Command: « Library: SPODTEST Environment: MyMainframe

» To toggle application workspace display

= From the View menu, choose Application Workspace.
Or:
Press ALT+2.

When the application workspace is displayed in the Natural Studio window, a check mark
is shown next to the Application Workspace command.

Creating a Base Application

You will now create two base applications with the names SPODAPPL1 and SPODAPPL2. You will
create them on the same development server that you have previously mapped in the library
workspace.
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» To create a new base application

1  In the application workspace, select the "Applications" node.
2 Invoke the context menu and choose New.
When you work with applications for the first time, the Connect Application Server dialog
box appears. You have to enter all required information for starting a session on the develop-
ment server. This session, which is called “application server session”, is used to access ap-
plication data.
When you start Natural Studio the next time and expand the "Applications" node, the applic-
ation server session is automatically started. The Connect Application Server dialog box will
appear only if additional information (for example, a password) is required.
Connect Application Server I,ﬁ,l
Server
Host name:
Server port:
Environment name:
Startup
Seasion parameters:
User ID: NATURAL
Password:
OK || Cancel || |Hep |
3  Inthe Host name text box, enter the name of the development server on which the application
data are stored.
4 In the Server port text box, enter the TCP/IP port number of the development server.
5  If Natural Security is installed on the development server, specify the required password in
the Password text box. Otherwise, leave this text box blank.
6  Choose the OK button.
The application server is connected.
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Since you have chosen the New command from the the context menu, the New Application

- Base Settings dialog box appears.

-

MNew Application - Base Settings

[S5CS)

Mame: |
Matural

Type of Application

@ Base (") Compound
Type of Server
@ Mainframe (71 Dpen Systems
< Bac et [ Cancel ] [ Help

7 Enter the name SPODAPPLI for your first base application.
8  Make sure that the Base option button is selected.

Select the option button for the type of server: since this tutorial assumes that you have mapped

to a remote mainframe environment, choose the Mainframe option button.

10 Choose the Next button.

The New Application - Description dialog box appears.

-

MNew Application - Description
Description:
Matural
4 ;
<Back || Net> | | Cancel | | Heb

Natural Single Point of Development
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11
12

13

14

15

Optional. Enter a description for your application. This can be any text.

Choose the Next button.

The New Application - Environment Settings dialog box appears.

MNew Application - Environment Settings L&J

Server: B2
Matural Port: 4777
Profile Settings
MName:
Database |D:

File number:

<Back | Fnsh | | Cancel | | Heb

b

The name and port number of the application server that you have previously mapped in the
Connect Application Server dialog box are provided as the default values for the new applic-
ation. For this tutorial, we will use the default values.

| Note: Itis also possible to use another development server.

Optional. Specify the profile settings (name, database ID and file number) to control the session
settings as on the mainframe.

Choose the Finish button.

| Note: If a password is required, the dialog box in which you have specified the connec-

tion information is shown again. Server name, port number and session parameters
cannot be changed in this dialog box. They are fixed for an application. If this dialog
box appears, specify the password and choose the OK button.

The new application is now mapped. It is shown in the application window. Each time you
map an application, a new development server session is started for this application.
Repeat the above steps to create the second base application with the name SPODAPPL2. You

will later link objects to these two base applications.

| Note: Since you have already defined the connection information, the Connect Applic-
ation Server dialog box is not shown for your second application.
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Creating a Compound Application

You will now create a compound application with the name SPODCOMP.

» To create a new compound application

1
2

In the application workspace, select the "Applications" node.

Invoke the context menu and choose New.

The New Application - Base Settings dialog box appears.
Enter the name SPODCOMP for your compound application.
This time, select the option button Compound.

Choose the Next button.

The New Application - Description dialog box appears.
Optionally. Enter a description for your application. This can be any text.

Choose the Finish button.
You will later link your two base applications to this compound application.

| Note: Ifa password is required, a dialog box appears in which you have to specify the

password.

Your application workspace should now look as follows:

Application Workspace N
+TE SPODAPPLA
+TE SPODAPPLZ
-y SPODCOMP

,::ﬂ Logical View ,;, Flat View u;a File View
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Linking Objects to a Base Application

You can link any existing Natural object of the attached development server (for example, a program

or map) to your application.

With the exercise below, you will link the following objects to your base applications:

SPODAPPL1 |SPODAPPL2

SPODADD |syuB1 SUB2
SUB2

SPODLIB | M AINPGM |MENU1
MENU1 |PROGI
PROG3 TEXT2
TEXT1

SPODTEST PGMCHECK

» To link objects to a base application

1  In the application workspace, select your base application SPODAPPLI.

2  Invoke the context menu and choose Link.

The Link Objects to Application dialog box appears.

3 From the Look in drop-down list box, select the library SPODADD.

The content of the selected library is now shown in the dialog box.

Link Objects to Application

|

Lookin: | SPODADD -

i sust

i sues

Ohject Mame:

Ohjects of Type: All Programming Objects

v] [ Cancel
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4  Press and hold down CTRL and select the objects SUB1 and SUB2.
5  Choose the OK button.

When you expand the nodes for the application SPODAPPL1 in the application workspace, the
linked objects are shown.

Application Workspace alx
=-[%& Applications

i sroonrri
_% User Libraries

—-{Z SPODADD

-0 SPODCOMP

:::ﬂ Logical View |; Flat View I u;a File "v.ﬁewl

| Note: In the logical view, the selected objects are automatically placed in the correspond-

ing folders (for example, a "Subprograms" folder is shown for all subprograms that
you have selected).

6  Repeat the above steps to link the remaining objects as indicated in the above table.

| Note: If you notice that you have linked a wrong object to your base application, you

can unlink it. To do so, select the wrong object in the application workspace, invoke
the context menu and choose Unlink.

Linking Base Applications to a Compound Application

You can link any existing base application on the connected application server to a compound
application. You can also link base applications which have different development server settings
(that is, the session that is started for the application server may run on a different development
server). A compound application thus allows you to combine objects that cannot be combined in
the library workspace.

You will now link your two base applications SPODAPPL1 and SPODAPPL2 to your compound ap-
plication SPODCOMP.
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» To link base applications to a compound application

1  In the application workspace, select your compound application SPODCOMP.

2 Invoke the context menu and choose Link.

The Link Application to Application dialog box appears.

Link Application to Application ﬁ

Applications:
Mame Type Server Port
SPODAPPLA Base IEMZ 4722
SPODAPPLZ Base IEM2 4722

NATURAL

0K Cancel || Hep

3 Select your first base application named SPODAPPLI.

] Note: If a password is required, specify it in the Password text box. If you do not specify
arequired password, an additional dialog box will later prompt you for this information.

4 Choose the OK button.
5 Repeat above steps to link second base application named SPODAPPL2.
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Managing Linked Objects

The objects in the application workspace are just references (or links) to the objects on the devel-
opment server. They are not copies. For example, when you add a new program it will be visible
in both the library workspace and the application workspace.

When you want to modify an object, you can do this either in the library workspace or in the ap-
plication workspace. When an object is currently being modified by another user, the corresponding
lock message is shown. A lock message is also shown when you try to open an object in the library
workspace that you are currently modifying in the application workspace (and vice versa).

Note: Not all commands are available in the application workspace. For example, the

commands Delete and Rename are only available in library workspace.

The following exception applies in the application workspace when cataloging (CATALL) the objects
in a library: only the objects that have been linked with the application are cataloged (i.e. only the
objects that are shown in the application workspace). The objects that are only shown in the library
workspace are ignored. To find out which objects have been cataloged for the library that is currently
selected in library workspace, issue the LIST * command from the command line. You can then
check the catalog date in the resulting window.

Mapping an Application

In addition to the applications you create yourself, you can also map applications from other users
so that they are shown in the application workspace. You can map all applications that have
already been defined on the development server that you have defined in the Connect Application
Server dialog box.

Each time you restart Natural Studio, your application workspace is empty. To display the previ-
ously mapped applications, expand the "Applications" node. As a result, all previously mapped
applications are mapped again. If a password is required, further dialog boxes may appear in
which you have to specify the missing information.

The following exercise explains how to map applications that you have not previously created.

» To map an application

1  In the application workspace, select the "Applications" node.

2 Invoke the context menu and choose Map.

The Map Application dialog box appears providing a list of all defined applications.
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Map Application [&J
Applications:

Mame Type Server Port
SPODAPPLI Base IBM2 4732
SPODAPPLZ Base IBM2 4752
SPODCOMP Compound 0

User IO NATURAL

Password:

0K | Cancel || Hebp

3  Select the application you want to map.

| Note: If a password is required, specify it in the Password text box. If you do not specify

arequired password, an additional dialog box will later prompt you for this information.

4  Choose the OK button.

The mapped application is now shown in the application workspace.

Displaying the Properties of an Application

If you need information about an application in the application workspace or if you want to change
the settings of the application, you can display its properties.

» To display the properties of an application

1 Inthe application workspace, select the application for which you want to display the prop-
erties.

2 Invoke the context menu and choose Properties.

Or:
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Press ALT+ENTER.

A dialog box appears displaying the properties for the selected application. Example for a
base application:

Application MYAPP1 Properties e

General | Description | Environment | Entry Points

MName: MYAPP1

Type: Base (Mainframe)

Modffied: 20130703 11:57 NATURAL
Created: 20130703 11:57 MNATURAL

State: Connected.

| oK || Cancel Apply Help

3  Select the tabs in this dialog box to view the corresponding properties.

4 Choose the OK button to close the dialog box.

You have now successfully completed this tutorial.
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